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1.1 FS-RI Reinsurance

1.1.1 Objects with Personal Data and Geographical Data (Changed)

Use

As of SAP Reinsurance Management 7.0, new data fields are available for objects containing personal or
geographical data.

The new data fields for objects with the category Person are Gender, Date of Birth and Date of
Death.

The new data fields for objects with the category Geographical Data are Longitude and Latitude.

The new data fields are not available on the SAP GUI but are available only for the management of
objects using new transactions in SAP NetWeaver Business Client.

Before you can use the new fields, you have to make the settings in Customizing for object categories
needed to assign personal or geographical data to an object category.

Effects on Data Transfer

You can manage the new fields for the object using the FS-RI BAPIs for the object.

Effects on Customizing

For more information, see Customizing for FS­RI Reinsurance under FS­RI: Risk Manager (Non­Life) >
Object Management > Edit Object Categories.

See also

API Functions
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1.1.2 Compat Packages for Obsolete Elements (New)

Use

As of SAP Reinsurance Management 7.0, function modules, classes, and ABAP Dictionary elements that
are no longer needed for the current system functions and are available only to ensure compatibility with
earlier releases are assigned to compatibility (compat) packages.

These objects are no longer maintained and should therefore not be used for customer implementations.

The compatibility packages are listed below. For more information about the contents of these packages,
see SAP Note 1885229.

Risk Manager Non-Life 

n/a

Basic System 

- /MSG/RC_COMPAT_70: COMPAT Main Package for Exported Objects in 7.0

- /MSG/RCA_COMPAT_70: COMPAT Package for Exported Account Objects in 7.0

- /MSG/RCT_COMPAT_70: COMPAT Package for Exported Treaty Objects in 7.0

- /MSG/RCX_COMPAT_70: COMPAT Package for Exported Cross Objects in 7.0

1.1.3 Business Function (New)

Use

As of SAP Reinsurance Management 7.0, the new business function Flexibility of Core Reinsurance
Processes 2 is available.

When you activate this business function, you can use new features from different areas of SAP
Reinsurance Management.

For more information about these new features, see the following release notes:

- Limit Check (New)

- Bordereau with Target Balance (New)

- Enhancement of Calculation of Adjustment of NP Premiums (New)

- Actual/Estimate Indicator for Result-Dependent Conditions (New)
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- Renew Policy (New)

- Display Fields in Summary of Accounts (Changed)

- Restriction of Search Results in Risk Manager Non-Life (Changed)

- Enhancement of Premium Schedule Function in Risk Manager Non-Life (Changed)

- Creation of Bordereaux in Risk Manager Non-Life (Changed)

- Summarization of Group and Participation Journals (Changed)

- Handling of Expired Currencies (Changed)

- Assumed Fields in Manual, Ceded Accounts (Changed)

- Individualization and Enhancement of Account Assignment (Changed)

- Flexible Control of Required Entry Fields for Loss Numbers (Changed)

- Result-Dependent Conditions from Linked Treaties (Changed)

- Navigation Between Sections in a Treaty Period (New)

- More Flexible Entry Options for Reinsurance Capacity (New)

- Status Sequence at Period Level (New)

- Obligatory Connecting Treaties in Reinsurance Programs (New)

- Objects Containing Personal and Geographical Data (Changed)

Some new features require Customizing settings.

For more information about these settings, see the corresponding release note for the new feature.

The following business functions are a prerequisite for the business function Flexibility of Core
Reinsurance Processes 2 (/MSG/FSRI5):

- Refinement of FS-RI Accounting Technique (/MSG/FSRI1)

- Extended Business Service (/MSG/FSRI3)

- Flexibility of Core Reinsurance Processes (/MSG/FSRI4)

See also

For more information about SAP Reinsurance Management (FS-RI), see SAP Library under SAP for
Industries > SAP for Insurance > SAP Reinsurance Management.

For more information about the business function, see SAP Library for SAP Reinsurance Management >
Business Functions.

1.1.4 Template for User Menus (New)

Use

As of SAP Reinsurance Management 7.0, two roles are available as copy templates:
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- The role /MSG/FSRI_700_TEMPLATE is used to create individual roles for use in SAP
Reinsurance Management.

- The role /MSG/FSRI_700_NWBC_TEMPLATE is used to create individual roles for use by SAP
Reinsurance Management 7.0 with SAP NetWeaver Business Client (NWBC).

For more information about how to use these roles, see the documentation for the relevant role.

1.1.5 Task List Templates for Schedule Manager (Changed)

Use

As of SAP Reinsurance Management 7.0, new background jobs have been added to the task list templates
/MSG/ISRI0 and /MSG/FSRI0.

You can find the background job Adjust NP Premiums in the task list /MSG/ISRI0 in the Flexibility of
Core RI Processes 2 folder for the business function Flexibility of Core RI Processes 2 (/MSG/FSRI5).

You can find the background job Adjust NP Premiums in the task list /MSG/FSRI0 in the Premium
Schedule folder under Functions for Period-End Closing.

See also

Enhancement of Calculation of Adjustment of NP Premiums

1.1.6 FS-RI-B Basic System

1.1.6.1 Reconfiguration of the Loss Process (New)

Use

As of SAP Reinsurance Management 7.0, new user interface sets are available for the loss functions.

These are applications that run in SAP NetWeaver Business Client (NWBC) and that exist in parallel with
the existing SAP ERP interfaces. The structure of the new interface sets is geared towards the user's
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workflow.

The following Web Dynpro ABAP applications have been introduced:

- WDY_APPLICATION - Loss Management: This application is used to create, edit, display, and
release losses and corresponds to the ERP transactions /MSG/R_U1, /MSG/R_U2, and /MSG/R_U3.
The linear, task-oriented structure of the new interface for loss management comprises the screens
Loss, Cedent, Activity, FGU Account, Coverage, and Preview.

- WDY_APPLICATION - Loss Group Management: This application is used to create loss groups
and to assign losses to the group.

- WDY_APPLICATION - Close Loss

- WDY_APPLICATION - Loss Figures: This application is used to create overviews of the account
totals based on account, loss, and coverage information.

The entity Activity has been introduced as a new logical object. This entity bundles all FGU accounts
for an activity, as well as any accounts derived from these FGU accounts, and is used to provide an
overview of the amounts reported by a cedent for a loss (even in the case of multiple FGU accounts) so
that the origin of derived accounts can be traced in more detail at a later date.

For more information, see the application help.

Effects on Existing Data

The Web Dynpro ABAP applications that are enabled to run in NWBC provide new functions for editing
loss data. However, existing data is changed only explicitly by the user and its technical structure remains
unchanged.

The new entity Activity does not change existing data but merely enhances this data. To ensure the
consistency of data, however, you cannot use the classic application to edit a new loss that was created
using the Web Dynpro applications in NWBC if there is an open activity for this loss.

In all other respects, the activity is not relevant for the classic applications and these applications function
as normal without this entity.

Effects on Data Transfer

If you create or edit losses using the new Web Dynpro applications, the activity that has to be considered
when data is transferred is always added to these losses as an additional entity. There are no changes if
you are transferring only loss data that was edited in classic ERP transactions.

Effects on System Administration

A new role template (/MSG/FSRI_700_NWBC_TEMPLATE) is provided to enable the use of the new
NWBC applications.

You also have to activate the corresponding HTTP services from FS-RI in addition to the services for
operating NWBC using transaction SICF.

Effects on Customizing

If you want to assign numbers internally for the activity ID, you have to define a number range in
Customizing under Activity.

See also

- Documentation about losses in the user guide (application help)
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- Release note: Side Panels in NWBC Applications (New)

1.1.6.2 Side Panels in NWBC Applications (New)

Use

As of SAP Reinsurance Management 7.0, in SAP NetWeaver Business Client (NWBC) for loss
management (WDY_APPLICATION) you can show additional information about the data being edited.

This information is shown on a side panel that is displayed when you click an arrow on the right-hand side
of the screen.

In the standard system, this side panel has two areas known as Collaborative Human Interface Parts
(CHIPS):

- The CHIP Overview of FGU and Treaty Figures displays the current FGU balance and the treaty
figures from activities that have already been finalized for the selected cedent. This CHIP is
available only in the area of loss management and only for cedent-dependent screens (from the
activity onwards).

- The CHIP Attachments displays the files that were attached to the basic data for the loss, activity,
and FGU account. This CHIP is available in loss management, in the loss group, and in object
management.

If necessary, you can add your own CHIPs to the side panel.

Effects on System Administration

The side panel exists only in NWBC. If you call the Web Dynpro applications in a Web browser, the side
panel is not displayed.

You have to activate the corresponding HTTP services from FS-RI in addition to the services for
operating NWBC using transaction SICF.

See also

- Documentation about losses in the user guide (application help)

- Release note: Reconfiguration of the Loss Process

1.1.6.3 FS-RI-B-TTY Treaty

1.1.6.3.1 Status Sequence at Period Level (Changed)

Use
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As of SAP Reinsurance Management 7.0, you can use Customizing to restrict the possible successor
statuses for a status used at treaty period level.

The definition of this kind of successor status allows you to map the technical processes relating to treaty
changes in more detail and to avoid unwanted status changes to treaty periods.

If a treaty period has a status for which you have defined at least one successor status, when you change
the treaty period status the system checks whether you have selected a valid successor status.

If a treaty period is assigned a status for which you have not defined a successor status, you can assign any
status you want to the treaty period as the next status.

The checks relating to the plausibility of a successor status are performed in FS-RI Treaty Management
and also in the treaty BAPIs /MSG/BAPI_TTY_CHANGE_MULTIPLE,
/MSG/BAPI_TTY_CREATE_MULTIPLE, and /MSG/BAPI_TTY_MODIFY_MULTIPLE.

These checks do not include copy programs for the treaty, which can set the copy status to any source
status.

Effects on Customizing

You can define successor statuses in Customizing for Basic System under Treaty > Define Statuses.

In the case of status values that are assigned the usage Periods, you can navigate to a new, third, level to
define the valid successor status.

1.1.6.3.2 Result-Dependent Conditions from Linked Treaties (New)

Use

As of SAP Reinsurance Management 7.0, related result-dependent conditions and compensation rules
from linked treaties are displayed in a Basic System treaty in addition to the result-dependent conditions
and compensation rules defined in a treaty. This provides you with a more detailed overview of which
conditions affect which treaty. The conditions and compensation rules from linked treaties are displayed
only and can still only be edited in the treaty in which they were created.

Effects on Existing Data

The result-dependent conditions and compensation rules from linked treaties are now also displayed in a
treaty on the tab page for compensation rules (at period level) and on the tab page for result-dependent
conditions (at period, section, and partner involved level). In each case, you can navigate to a detailed
view.

For each condition, the system displays the name of the treaty in which the condition was originally
defined. The system displays the compensation rules and result-dependent conditions that were defined in
treaty periods that affect the treaty period being displayed.
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This algorithm applies only to the display of data in a treaty and may differ from the result of the
calculation of result-dependent conditions in a background job.

1.1.6.3.3 Navigation Between Sections in a Treaty Period (New)

Use

As of SAP Reinsurance Management 7.0, you can switch at section level in a Basic System treaty directly
to the next or previous section in a treaty period. For this purpose, two new pushbuttons are provided next
to the section display.

This makes it easier to navigate within the treaty and you no longer need to go to period level if you want
to switch between sections.

Effects on Existing Data

Two new pushbuttons are available next to the section name at section level in a Basic System treaty.

1.1.6.3.4 More Flexible Entry Options for Reinsurance Capacity (Changed)

Use

As of SAP Reinsurance Management 7.0, you can make more flexible entries in the liability fields in
surplus reinsurance treaties (Retained Line, No. of Lines, and RI Capacity).

Entries can be made in all three fields.

You can still have the system calculate the reinsurance capacity based on the retained line and number of
retained lines you enter but you can now also enter the reinsurance capacity directly.

The system uses the retained line or number of retained lines you enter to calculate the missing third
value.

______________________________________________________________
SAP AG 8

SAP-System______________________________________________________________



1.1.6.3.5 FS-RI-B-TTY-CM Contract Manager

1.1.6.3.5.1 Obligatory Connecting Treaties in Reinsurance Programs (New)

Use

As of SAP Reinsurance Management 7.0, Risk Manager Non-Life supports intra-company reinsurance via
obligatory connecting participations.

A new checkbox entitled Create Assumed Business Side in Risk Manager has been added to the treaty
header data for this purpose.

You can set the checkbox in a ceded, obligatory reinsurance treaty if an owner company is involved 100%
as the reinsurer in all periods and sections.

If you enter this type of treaty in a reinsurance program (RI program), you can have the system
automatically create obligatory connecting participations as part of the Cession Calculation function in
Risk Manager Non-Life. The way in which data for the cession rule and the portfolio treaty is supplied
can be implemented to meet customer requirements. This ensures that the system continues to process the
obligatory connecting participation without further manual action from the user.

The related assumed connecting account in the next company code is created in Risk Manager Non-Life
as part of the Transfer to Basic System function.

This provides you with a alternative to the manual creation of connecting participations in a dialog
process or using a BAPI.

You cannot enter obligatory connecting treaties when you create a participation manually. Similarly,
obligatory connecting participations are not supported in primary insurance accumulations.

Effects on Existing Data

The new checkbox Create Assumed Business Side in Risk Manager is available on the Header Data tab
page under the control data for ceded, obligatory non-life treaties.

The Cession Calculation function provides a new Business Add-In (BAdI) that can be used to supply data
for the cession rule and portfolio treaty of obligatory connecting participations.

Effects on Data Transfer

The new checkbox Create Assumed Business Side in Risk Manager is included in the BAPIs
/MSG/BAPI_TTY_MODIFY_MULTIPLE and /MSG/BAPI_TTY_GETDETAIL.

The new checkbox Create Assumed Business Side in Risk Manager is extracted by the export to Excel
function and is also available for the treaty printout.
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1.1.7 FS-RI-RMN Risk Manager Non-Life

1.1.7.1 Enhancement of the Premium Schedule Function in Risk Manager
Non-Life (Changed)

Use

As of SAP Reinsurance Management 7.0, the functional scope of the premium schedule in Risk Manager
Non-Life has been enhanced:

- The creation of premium schedules has been improved

- The creation of distribution plans is supported

- The portfolio rule accounting times have been enhanced

- The creation of accounts has been improved

Premium Schedule

The creation of premium schedules has been improved with regard to the default values and information
entered about the relevant periods. If a premium schedule applies to a specific treaty term or period, the
system enters the currently displayed participation period as the default premium schedule period. In the
case of a premium schedule for a specific period, you can also define a default value for the premium
reference period in the Customizing activity Edit Defaults for Premium Schedule.

To get a better overview of the installments of a schedule for one-time premiums, the system will in
future display the period in which the premium schedule installments are cleared.

In future, you can define the due date of a premium schedule installment as being before the start date of
the participation. This means that the due date can lie outside the validity period of the participation.

Distribution Plan

As of Release 7.0, the distribution plan required for a premium schedule account is generated
automatically when you create the premium schedule provided the structural characteristics of the related
policy sections each have a single unique entry that is not a hierarchical node. As a result, the distribution
plan consists of a 100% entry. Existing distribution plans are not regenerated.

Account

You can use the new checkbox Create Accounts for Premium Schedule to specify that accounts are
created immediately for the premium schedules of a participation. An account is created if the selected
participation has been saved in a status that is not reversed and allows posting. You can trigger this online
using the Confirm function and in the RM Combined Background Job and RM Adjustment for
Changes to the Basic System background jobs. You can also have the system trigger this using the API
Confirm for a reinsured policy.

Note: It is no longer necessary to run the Create Accounts for Premium Schedule background job for
these participations.
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You can enter all the technical data needed to execute the immediate creation of accounts for premiums in
the Customizing activity Edit Defaults for Premium Schedule.

You can enter an informative description for each individual installment of a premium schedule. This
description is then copied to the account that is created. You can use these individual descriptions to
identify the accounts for a premium schedule that were created automatically.

When you reverse a premium schedule on a Risk Manager screen, it will be possible in future to enter a
reversal reason. This reason is then used as the name of any resulting accounts and is displayed on the
screen for the premium schedule.

Effects on Existing Data

The Create Accounts for Premium Schedule checkbox has been added to the participation header data.
You can maintain the setting for this checkbox in Participation Management. This setting is displayed on
the screen for the premium schedule.

The text field Description of Installments has been added to the premium schedule installment. A new
entry column is provided in the premium schedule details. Any entry you make in this column is copied to
the resulting account as the account name. Otherwise, the standard text is used as the account name.

The text field Reason for Reversal has been added to the premium schedule header. When you reverse a
premium schedule, you can enter the reversal reason in a dialog box. This reversal reason is then used as
the name of the account in any resulting accounts.

If you have created a premium schedule for a participation, the system creates the distribution plan
required for this automatically under certain circumstances.

Effects on Data Transfer

The field PREM_ACC has been added to interface parameter /MSG/BAPI_PRT_HD in BAPI
/MSG/BAPI_RISK_MODIFY_MULTIPLE so that you can indicate that accounts for premium
schedules are generated immediately for the participation.

The field ACC_DESC has been added to interface parameter /MSG/BAPI_PRTPREM in BAPI
/MSG/BAPI_RISK_MODIFY_MULTIPLE. You can enter a description of the installments in this field.

The same fields have been added to structures /MSG/BAPI_GD_PRT_HD and
/MSG/BAPI_GD_PRTPREM in BAPI /MSG/BAPI_RISK_GETDETAIL.

Note: The functions provided by the Create Accounts for Premium Schedule checkbox are not available
for participations for information purposes, participations with the category Retention, and
participations that are assigned P2R cession groups.

Effects on System Administration

It is no longer necessary to run the Create Accounts for Premium Schedule background job for
participations for which the checkbox has been set.

Effects on Customizing

Before you can create accounts for a premium schedule for a selected participation, you have to make the
necessary settings in Customizing for the relevant company code.

This is also where you enter the default values for the premium reference period of premium schedules
that apply for a specific period.
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You can make the settings in Customizing for FS-RI Reinsurance under FS-RI Risk Manager (Non-Life)
   Defaults    Edit Defaults for Premium Schedule.

You must enter the following:

- The relevant company code

- The time limit in days

- The scope of processing for accounts

- The default premium reference period

1.1.7.2 Summarization of Group and Participation Journals (Changed)

Use

As of SAP Reinsurance Management 7.0, the functional scope of the summarization of group and
participation journals for manual groups and participations has been enhanced and extended to cover
manual groups and manual participations. When you create and change participations for automatic
cession groups these are no longer excluded from summarization.

Moreover, the summarization of manually ceded group and participation journals is supported for the
following groups:

- Manual cession groups

- Prior cession groups

- Manual/automatic cession groups

The enhancement of the functional scope of summarization reduces the number of group and participation
journals in facultative reinsurance business and leads to more transparent data and to a significant
improvement in system performance.

The following groups are not summarized:

- Reversal groups

- Prior reversal groups

- P2R cession groups

If a connecting participation is assigned to a group relevant for summarization, the system does not
summarize the group and participation journals.

Effects on Existing Data

If the group and participation journals do not contain any different data relevant for summarization, the
system summarizes the group and participation journals. When you confirm a superior object, the system
summarizes the data according to the Customizing settings and, if necessary, reduces the existing data for
group and participation periods.
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1.1.7.3 Renew Policy (New)

Use

As of SAP Reinsurance Management 7.0, you can renew a policy in Risk Manager more quickly.

The system renews all policy sections of a policy that is not reversed up to and including the
corresponding assumed participations for a specified period. This reduces the number of manual activities
and the time needed to renew a policy.

The system renews one policy per policy section including the corresponding objects.  These are:

- Values insured

- Premiums

- Policy section groups

- Cedent participations

- Cedent participation groups

- Assumed participations

The system creates a new period to which it copies all the period-dependent data of the most recent
period.

If there was an accumulation assignment, the system adjusts this assignment to the new period.

1.1.7.4 Restriction of Search Results in Risk Manager Non-Life (Changed)

Use

As of SAP Reinsurance Management 7.0, you can restrict the maximum number of hits displayed in the
simple and extended search. This applies to the following dialogs:

- Contract Manager (depending on the starting point for the search)

- Risk Manager Account 
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- Risk Manager Bordereau 

- Object Manager 

This enables you to reduce search criteria and therefore avoid lengthy response times to search queries.
The system sets the number of hits at 200 by default.

The system returns the most current results, sorted as follows:

- Contract Manager: sorted in descending order by creation date and time

- Risk Manager Account: sorted in descending order by account or posting number

- Risk Manager Bordereau: sorted in descending order by creation date and time

- Object Manager: sorted in descending order by creation date and time

The specified number of hits determines the number of hits within which the system sorts the results to be
displayed according to the existing rules in ascending order by search object ID.

1.1.8 FS-RI-AC Account

1.1.8.1 Individualization and Enhancement of Account Assignment (Changed)

Use

As of SAP Reinsurance Management 7.0, you can individualize and enhance the fields displayed on the
account dialogs in Basic System and Risk Manager Non-Life on the Account Assignments tab page.

You can sort and filter the assignments. You can show and hide fields and change the sequence of fields.
You can also add your own fields to be displayed.

The following optional fields can also be displayed for source and target accounts:

- Treaty Number and Treaty Name

- Number of Partner Involved and Name of Partner Involved

- Actual/Estimate Indicator and Name of Actual/Estimate Indicator

- Account Status and Account Description

- Involvement Number and Involvement Text

Effects on Existing Data

New fields are provided that can be displayed on the account dialogs in Basic System and Risk Manager
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Non-Life. These fields are only displayed. No changes are made to the existing data.

1.1.8.2 Bordereau with Target Balance (New)

Use

As of SAP Reinsurance Management 7.0, a target balance function is available in the Basic System
bordereau and in the Risk Manager bordereau.

You can enter a target balance in the bordereau. The system compares the target balance with a reference
balance and calculates a difference amount. The reference balance corresponds to one of the four balances
contained in the bordereau, such as the cash balance.

You can release or transfer generated accounts to Basic System only when the reference balance
corresponds to the target balance.

The currency of the target balance is the display currency of the bordereau.

If you are working with the target balance then you have to enter all postings in the display currency.

Effects on Customizing

You use calculation base 4 to specify the reference balance for the target balance function. You can
configure this in Customizing for Basic System and Risk Manager under Edit Defaults for Accounting.

1.1.8.3 Assumed Fields in Manual, Ceded Accounts (Changed)

Use

As of SAP Reinsurance Management 7.0, you can enter data for an assumed treaty and assumed section in
a Basic System account when you create and change manual accounts for ceded treaties.

This assumed treaty must be an assumed treaty or a connecting treaty that covers all the structural
characteristics in the account header and postings, including the assigned loss.

By entering the related assumed treaty, you can improve the "readability" of the account data.

When you enter an assumed treaty in a Basic System account, the system determines the main cedent of
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the assumed treaty and enters this as the assumed cedent in the account. All the other assumed fields in
the account are left empty.

If you have entered an assumed participation in a Risk Manager account, the system determines the
related assumed treaty and its main cedent and enters these in the corresponding assumed fields in the
account. All the other assumed fields in the account are left empty.

Effects on Existing Data

You can now make entries in two new fields (Assumed Treaty and Assumed Section) in a Basic
System account when you create and change manual accounts for ceded treaties.

These fields are only displayed in all other types of treaty.

The Accounting Year for Assumed Business and Accounting Period for Assumed Business fields are
generally for display purposes only. If entries are made in the Assumed Treaty and Assumed Section
fields, the remaining assumed fields with the exception of the Assumed Cedent field are not filled and
remain empty.

1.1.8.4 Display Fields in Summary of Accounts (Changed)

Use

As of SAP Reinsurance Management 7.0, you can use the search results layout in the summary of
accounts in Basic System and Risk Manager Non-Life to show all the relevant technical fields available
for searching for accounts. This also applies to the fields belonging to the Extended Search in Risk
Manager Non-Life.

This increases the transparency of the search results and allows you to analyze existing accounts in a more
specific way.

The following new, optional, fields can be displayed in the summary of accounts in Basic System:

- Treaty Text 

- Name of Actual/Estimate Indicator 

- Number of Account Cedent and Name of Account Cedent 

- Number of Partner Involved and Name of Partner Involved 

- Involvement Number and Involvement Text 

- Section and Section Name 

- Accounting Unit and Accounting Unit Name 

- Class of Business and Class of Business Name 

- Financial Year and Financial Period 
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- Accounting Year, Accounting Period, and Name of Accounting Period 

- Loss Reference 

In addition to the Basic System fields, the following new, optional, fields can be displayed in Risk
Manager Non-Life:

- Policy and Policy Name 

- Participation and Participation Name 

- Original Participation and Name of Original Participation 

- Gross Participation and Name of Gross Participation 

- Assumed Cedent Number and Name of Assumed Cedent 

- Line of Business and Name of Line of Business 

- Accounting Frequency and Name of Accounting Frequency 

- Account Origin and Name of Account Origin 

- Recipient 

- Created By 

Effects on Existing Data

New fields are provided that can be displayed in the summary of accounts in Basic System and Risk
Manager Non-Life. These fields are only displayed. No changes are made to existing data.

1.1.8.5 Flexible Control of the Required Entry Fields for Loss Numbers (New)

Use

As of SAP Reinsurance Management 7.0, you can control the required entry of loss numbers in loss
postings separately for proportional and non-proportional treaties.

The checkbox that indicates that the loss number is a required entry field now applies only to
non-proportional treaties. There is a new checkbox that now applies to proportional treaties.

Effects on Data Transfer

If you want to make the loss number a required entry for proportional treaties as well, you must configure
the new checkbox accordingly.
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Effects on Customizing

For more information, see Customizing for FS-RI Reinsurance   Basic System   Defaults   Edit
Defaults for Accounting.

1.1.8.6 Handling of Expired Currencies (Changed)

Use

As of SAP Reinsurance Management 7.0, you can define in Customizing whether when you create
accounts for released funds or opening reserves you want to keep the expired currency in the event of a
currency translation or whether you want to use the successor currency (as is currently the case).

This prevents uncleared open items in the current account system due to a currency translation and
improves the transparency of your data.

Effects on Customizing

You can activate the retention of expired currencies for released funds and opening reserves for each
company code.

You find the settings in Customizing for FS-RI Basic System under Default Values > Edit Defaults for
Accounting.

You can configure the following:

- Checkbox: Currency Translation for Funds

- Checkbox: Currency Translation for Opening Reserves

1.1.8.7 Key Enhancement for Accounting Unit in F&E Tables (New)

Use

As of SAP Reinsurance Management 7.0, the field AUNO (Accounting Unit) has been added as an
additional primary key field in the primary key in the following database tables:

/MSG/REARCURBES2 Items and rules for treaties for use in the F&E module

/MSG/RH_EARCURB2 History table for table /MSG/REARCURBES2

/MSG/REARCLOC Header entry in treaty-specific development patterns

/MSG/RH_EARCLOC History table for table /MSG/REARCLOC
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/MSG/REARCLOCP    Treaty-specific development patterns

/MSG/RH_EARCLOCP History table for table /MSG/REARCLOCP

/MSG/REARCLOCBEZ Treaty-specific name of treaty-specific development patterns

/MSG/RGRPEARCUR Items and rules for groups for use in the F&E module

/MSG/RH_GRPEARCU History table for table /MSG/RGRPEARCUR)

The field is left empty in the current version and is not used.

Effects on Existing Data

The introduction of this new primary key field does not affect the existing transaction data in the relevant
database tables.

Customizing data and master data are not affected.

The interface is not affected because the new primary key field does not appear on any screens.

Effects on Data Transfer

The new primary key field is not connected to the current version via an interface.

1.1.8.8 Creation of Bordereaux in Risk Manager Non-Life (Changed)

Use

As of SAP Reinsurance Management 7.0, when Risk Manager Non-Life bordereaux are created the
system reads the in-force business data that is valid at account creation.

This means, for example, that the signed line percentage of the participation matches the percentage that
was valid when the account was created and not, as was previously the case, the percentage that was valid
when the bordereau was created.

The system logs the following values when the account is created:

- The deductible and liability for the participation in facultative business

- The signed line of the ceded participation

- The status of the ceded participation

- The deductible and liability of the ceded treaty in obligatory business

- The signed line of the involvement of the ceded treaty

Effects on Existing Data

If you activate the business function, the system determines and temporarily saves the in-force business
data during account creation. Previously, these values were determined during bordereau creation.
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To ensure that these two methods are not mixed during bordereau creation, we recommend that you print
all the bordereaux before you activate the business function.

1.1.8.9 Enhancement of Calculation of Adjustment of NP Premiums (New)

Use

As of SAP Reinsurance Management 7.0, you can use the premium data for non-proportional treaties (on
the NP Premiums tab page) to adjust premiums.

A new background job is provided in Basic System for the adjustment of NP premiums. You can use this
program and the enhanced NP premium data in non-proportional, obligatory master treaties to instruct the
system to adjust advance premiums that have already been posted.

You can also enter your own NP premium data for each reinsurer if, for example, you have agreed
different fixed premium percentages with one or more reinsurers.

When the system calculates the NP adjustment premiums, it replaces the NP premium data for all shares
with this data. As soon as you enter share-specific NP premium data, the system calculates and creates the
NP adjustment premiums and the final premium for each share.

If you then want to calculate the reinstatement premiums based on the changed data, the system uses
proportional accounts only and calculates the reinstatement premiums for each share.

Effects on Existing Data

In the NP premium data in non-proportional master treaties, you can use the new field Calculation Base
for Losses Incurred to specify a calculation base for the losses incurred.

The Calculation Base field has been renamed Calculation Base for Final Subject Premium.

A new database table (/MSG/RNPANG_PR_A) has been provided for the entry of share-specific NP
premium data. A table has also been provided on the NP Premiums tab page for the entry of NP
premium data in non-proportional treaties.

Effects on Data Transfer

The field RBASISNR_SA has been added to interface parameter /MSG/BAPI_NPROP_PREM_DETAIL
in the BAPIs /MSG/BAPI_TTY_CHANGE, /MSG/BAPI_TTY_CHANGE_MULTIPLE,
/MSG/BAPI_TTY_CREATE, /MSG/BAPI_TTY_CREATE_MULTIPLE, /MSG/BAPI_TTY_MODIFY,
/MSG/BAPI_TTY_MODIFY_MULTIPLE and /MSG/BAPI_TTY_GETDETAIL so that you can provide
or import the calculation base for the losses incurred in NP treaties.

The parameter PTNPROPPREMDETAILSHARE has been added to the BAPIs
/MSG/BAPI_TTY_CHANGE, /MSG/BAPI_TTY_CHANGE_MULTIPLE,
/MSG/BAPI_TTY_CREATE, /MSG/BAPI_TTY_CREATE_MULTIPLE, /MSG/BAPI_TTY_MODIFY,
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/MSG/BAPI_TTY_MODIFY_MULTIPLE and /MSG/BAPI_TTY_GETDETAIL so that you can provide
or import different premium data for reinsurers.

This new data is extracted by the export to Excel function and is available for the treaty printout.

Effects on System Administration

Due to the creation of a new background job for adjusting NP premiums, you may have to reschedule this
program and adjust the Schedule Manager task list.

Effects on Customizing

A new origin indicator (NPPRA) has been created and assigned to the new accounting function.  You find
this in Customizing under Basic System > Accounting > Edit Origin Indicators for Accounts/Payments
and Basic System > Accounting > Edit Assignment of Origin Indicator.

To be able to adjust NP premiums, you must enter a target entry code for the relevant company code in
Customizing under Basic System > Default Values > Edit Defaults for Accounting (Calculation Fields).
You make settings for the entry code in the column Target Entry Code for Adjustment of NP Premiums.

1.1.8.10 Limit Check (New)

Use

As of SAP Reinsurance Management 7.0, you can check the limits entered in the treaty for accounts at the
touch of a button and when you release the account.

The system uses the LUD data from the treaty to check these limits.

Calling the Limit Check

You can start the limit check in two different ways:

- A new button entitled Check Limit  is available on the screen for the account in Basic System.

- You can start the limit check as part of the Release Account function.

If you run this function on the screen for the account, the system creates the totals for accounts for
proportional treaties based on the specified calculation base.  The system uses the amounts covered to
create these totals for non-proportional treaties. All accounts that have been released for the treaty, as well
as the account that is currently open, are relevant for this.

A screen appears that contains the information that is relevant for the limit check. The information is
displayed in the LUD currency or in the leading section currency. From this information you can see
whether the limits entered in the treaty have been exceeded.

Constraints 

- The limit check is not available in parallel background jobs, with the exception of background job
/MSG/R_ABR_BATCH_PP (release of accounts by treaty in parallel processes).

- Limit control (analysis of the LUD characteristics Area, Peril, Loss Class, and Accounting Unit)
is not supported for proportional treaties.
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- The Indexation and Interlocking functions are not supported for non-proportional treaties. If you
work with these functions, it is necessary to configure the limit check in Customizing so that it does
not raise an error if the limit is exceeded.

- Reinstatement agreements are not included in the limit check for non-proportional treaties.

- Alternative LUDs defined in the loss are not included in the limit check.

Effects on Existing Data

In proportional treaties, you can enter a calculation base in the LUDs within a section.

In doing so, you can specify whether you want these LUDs to apply to the original, to the treaty, or to the
share (the setting Share is only possible for assumed treaties).

In the case of proportional treaties, it is also possible to enter LUDs several times that are otherwise
identical but have different ranks and calculation bases.

Effects on Data Transfer

You can also use a BAPI to import the calculation base entered in the LUD as well as the setting made for
the LUD level (Original, Treaty, or Share).

This additional data is extracted by the export to Excel function and is available for the treaty printout.

Effects on Customizing

The Customizing activity containing the default values for accounts has been enhanced. You can control
whether you want the system to run the limit check when you release an account.

The following options are available:

1. No Check: The system does not check the limit when you release an account.

2. Warning If Limit Exceeded: The system checks the limit when you release an account.

- The system displays a warning message if the limit is exceeded.

- If you are releasing the account from the screen, you can confirm the warning message or
cancel the release.

- If you are releasing the account in a background job, the system releases the account and logs
the warning message.

3. Error If Limit Exceeded: The system checks the limit when you release an account.

- The system displays an error message if the limit is exceeded.

- The account cannot be released.

You find the settings in Customizing under FS-RI Reinsurance>   Basic System > Defaults>      Edit
Defaults for Accounting.
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1.1.9 FS-RI-CM Loss

1.1.9.1 Actual/Estimate Indicator for Result-Dependent Conditions (New)

Use

As of SAP Reinsurance Management 7.0, you can restrict the validity in Basic System of a
result-dependent condition to a specific actual/estimate indicator. This also applies to the related sliding
scale, the compensation rules, as well as to the condition templates.

This means that you can enter a condition with different values for final, estimate and forecast, for
example.

When you start the background job to calculate the result-dependent conditions, you can then use the
actual/estimate indicator for the target account to control which condition is used for the calculation. This
simplifies the way in which result-dependent conditions with different actual/estimate indicators are
handled.

Moreover, you can enter a calculation base in a result-dependent condition instead of in an entry code that
is offset against the calculation result of the condition. This is also possible in the condition templates.

When you start the background job to calculate the result-dependent conditions, the system then uses the
calculation base instead of the entry code for the calculation.

The actual/estimate indicator is provided on the treaty dialog in the following places:

- Period

- Displayed on the Result-Dependent Condition tab page

- Displayed on the Compensation Rules tab page

- Displayed and changed in the dialog box for copying result-dependent conditions

- Result-dependent condition

- Changed within a result-dependent condition on the Result-Dependent Condition tab page

- Displayed within the result-dependent condition on the Sliding Scale tab page

- Displayed within the result-dependent condition on the Compensation Rules tab page

- Partner involved

- Displayed on the Result-Dependent Condition tab page

- Displayed and changed in the dialog box for copying result-dependent conditions

- Section

- Displayed on the Result-Dependent Condition tab page

- Displayed and changed in the dialog box for copying result-dependent conditions

- Condition templates

- Changed on the Result-Dependent Condition tab page

- Displayed on the Sliding Scale tab page
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The Offset Against Calculation Base field is provided in the treaty dialog in the following places:

- Result-dependent condition

- Changed within a result-dependent condition on the Result-Dependent Condition tab page

- Condition template

- Changed on the Result-Dependent Condition tab page

Effects on Existing Data

Result-independent conditions or result-independent condition groups created before the current release
do not contain an actual/estimate indicator and are still valid for all accounts regardless of the
actual/estimate indicator.

The field Offset Against has been renamed Offset Against Entry Code.

A new key field has been added to the following database tables:

Table Field Data Element

/MSG/RVABHKOND SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RH_VABHKOND SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RSTAFFEL SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RH_STAFFEL SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RKOMPREG SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RH_KOMPREG SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RVABHKOND_P SCHAEKZ /MSG/R_VAKSCHAEKZ

/MSG/RSTAFFEL_P  SCHAEKZ /MSG/R_VAKSCHAEKZ

When you upgrade to the current version, you will need to convert the corresponding database tables (see
transaction SE14).

Make sure you have enough storage space for the conversion process.

Effects on Data Transfer

- The fields SCHAEKZ and RECH_RECHBASIS have been added to interface parameter
/MSG/BAPI_RESULT_DEP_COND in the BAPIs /MSG/BAPI_TTY_CHANGE,
/MSG/BAPI_TTY_CHANGE_MULTIPLE, /MSG/BAPI_TTY_CREATE,
/MSG/BAPI_TTY_CREATE_MULTIPLE, /MSG/BAPI_TTY_GETDETAIL,
/MSG/BAPI_TTY_MODIFY, and /MSG/BAPI_TTY_MODIFY_MULTIPLE.

- This additional data is extracted by the export to Excel function and is available for the treaty
printout.
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1.1.9.2 Embedded Search (New)

Use

As of SAP Reinsurance Management 7.0, there is a connection between the FS-RI system and Embedded
Search.

The following models are provided for searches in the standard system:

- RILOSS - for searching for losses

- RILOSSGROUP - for searching for loss groups

Effects on System Administration

You can schedule regular indexing for these models.

For more information about the administration of Embedded Search, see help.sap.com > SAP NetWeaver
7.4 > Application Help > Function-Oriented View > Search and Operational Analytics.

See also

For more information about the administration of Embedded Search, see SAP NetWeaver 7.4 >
Application Help > Function-Oriented View > Search and Operational Analytics > Embedded Search.

1.1.9.3 API Functions (Changed)

Use

As of SAP Reinsurance Management 7.0, new API functions are available for FS-RI functions in the area
of FS-RI object and FS-RI loss.

Moreover, you can also increase the accuracy of optimistic locking from seconds to microseconds for new
API functions and for API functions from previous FS-RI releases.

The implementation by RFC-enabled function modules allows you to access these functions using SAP
Web Dynpro applications, for example. This means you can design interfaces to meet your own needs.

For a more detailed description of the RFC-enabled function modules and an explanation of their
parameters, see the description of the function modules.

The following API functions are now available for FS-RI objects:

Function Module Function

/MSG/82_RO_F_BASIC_DATA Find object

/MSG/82_RO_C_BASIC_DATA Create object

/MSG/82_RO_U_BASIC_DATA Change object
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/MSG/82_RO_R_BASIC_DATA Read object

/MSG/82_RO_D_BASIC_DATA Delete object

The following API functions are now available for FS-RI losses:

Function Module Function

/MSG/82_RL_F_BY_ELEMENTS Find loss based on loss criteria

/MSG/82_RL_F_BY_USER_CHG Find loss based on user's last changes

/MSG/82_RL_C_BASIC_DATA Create basic data for loss

/MSG/82_RL_U_BASIC_DATA Change basic data for loss

/MSG/82_RL_R_BASIC_DATA Read basic data for loss

/MSG/82_RL_C_RICLAIM Create assignment of cedent to loss

/MSG/82_RL_U_RICLAIM Change assignment of cedent to loss

/MSG/82_RL_R_RICLAIM Read assignment of cedent to loss

/MSG/82_RL_P_CLOSE_RICLAIM Close loss at cedent level in loss

/MSG/82_RL_P_SIM_CLOSE_RICLAIM Simulate closing of loss at cedent level in loss

/MSG/82_RL_C_ACTIVITY  Create activity for cedent

/MSG/82_RL_U_ACTIVITY Change activity for cedent

/MSG/82_RL_R_ACTIVITY Read activity for cedent

/MSG/82_RL_P_CLOSE_ACT Close activity for cedent

/MSG/82_RL_P_CANCEL_ACT Reverse activity for cedent

/MSG/82_RL_C_APPL_TREATY_COV Create obligatory coverage for cedent

/MSG/82_RL_U_APPL_TREATY_COV Change obligatory coverage for cedent

/MSG/82_RL_R_APPL_TREATY_COV Read obligatory coverage for cedent

/MSG/82_RL_U_EXCESSOFLOSSDATA  Change obligatory and alternative excess of loss data
for coverage

/MSG/82_RL_R_EXCESSOFLOSSDATA Read obligatory and alternative excess of loss data for
coverage

The following API functions are now available for FS-RI loss groups:

Function Module Function

/MSG/82_RLG_F_BY_ELEMENTS Find loss group

/MSG/82_RLG_C_RILOSSGRP Create loss group

/MSG/82_RLG_U_RILOSSGRP Change loss group

/MSG/82_RLG_R_RILOSSGRP Read loss group

The following API functions are now available for FS-RI loss accounts:

Function Module Function

/MSG/82_RTA_CM_FGU_CLAIM_ACC Create FGU account

/MSG/82_RTA_U_FGU_CLAIM_ACC Change FGU account (header)

/MSG/82_RTA_U_FGU_CLAIM_POST Change FGU account (postings)

/MSG/82_RTA_R_CLAIM_FGU Read FGU account
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/MSG/82_RTA_D_FGU_CLAIM_ACC Delete FGU account

/MSG/82_RTA_P_FGU_RECALC Recalculate FGU account

/MSG/82_RTA_P_CALC_FGU_BAL Change FGU account balance

/MSG/82_RTA_R_C_FGU_BA_BY_ELEM Read FGU account balance

/MSG/82_RTA_P_FGU_ACC_PREVIEW Create preview with obligatory preview accounts

/MSG/82_RTA_P_FINAL_ACTIVITY   Finalize preview with obligatory preview accounts

/MSG/82_RTA_C_PREV_CLAIM_ACC  Create obligatory preview account

/MSG/82_RTA_U_PREV_CLAIM_ACC Change obligatory preview account

/MSG/82_RTA_R_SIM_RES_BY_ACT Read obligatory preview account (details)

/MSG/82_RTA_R_L_C_OVBYACT Read obligatory preview account (overview)

/MSG/82_RTA_D_PREV_CLAIM_ACC Delete obligatory preview account

/MSG/82_RTA_R_CL_FGU_BAL_OV Read overview of distribution of FGU figures

/MSG/82_RTA_R_LOSS_OV_BY_ELEM Read overview of loss figures (overview)

/MSG/82_RTA_R_LOSS_OV_STRC_BYE Read overview of loss figures (structural
characteristics level)

/MSG/82_RTA_R_LOSS_OV_ACC_BYE Read overview of loss figures (accounts level)

/MSG/82_RTA_R_TTY_ACC_BAL_OV  Read overview of loss figures (covered amounts level)

Effects on Existing Data

The attribute CHANGETIMESEQUENCE has been added to the following database tables so that values
in microseconds can be entered for optimistic locking:

/MSG/HPOLICY_HD Risk Manager Non-Life policies

/MSG/HH_POLICYHD History for Risk Manager Non-Life policies

/MSG/HGRP_HD Risk Manager Non-Life groups

/MSG/HH_GRP_HD History for Risk Manager Non-Life groups

/MSG/HOBJECT Objects

/MSG/HH_OBJECT History for objects

/MSG/RVTG Treaties

/MSG/RH_VTG History for treaties

/MSG/RSCHADEN Losses

/MSG/RH_SCHADEN History for losses

/MSG/RABR Accounts

/MSG/XABR Adjustment table for accounts

Effects on Data Transfer

If you want to use the improved accuracy for optimistic locking for new API modules or for API modules
from a previous FS-RI release, you have to integrate the new optional parameter
CHANGETIMESEQUENCE from the version information for the API interface.

See also
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Release note: Reconfiguration of the Loss Process
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